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I. Enoncé du problème 
Le STARCORE est un microcontrôleur 16 bits dédié à des applications électroniques embarquées 

variées. Les caractéristiques de ce composant sont données de l’annexe A.  

Afin de développer une brique « intelligente » programmable et modulaire, votre entreprise a décidé 

de fabriquer une carte fille embarquant un STARCORE monté dans un boitier QFP64. Les 

caractéristiques de cette carte sont données dans l’annexe B.  

Votre mission est de participer au développement du circuit imprimé du STARCORE, notamment sur 

les questions de compatibilité électromagnétique (CEM). En effet, afin de garantir la fiabilité de 

l’application en environnement difficile et afin de respecter les exigences en terme de CEM, il est 

nécessaire de veiller à cet aspect durant les phases de conception. Une de vos missions concerne le 

problème d’émission conduite produite par l’activité du composant (cf. annexe C). La contrainte fixée 

sur le niveau d’émission conduite est la suivante : 

� Le niveau d’émission conduite mesuré sur le nœud d’alimentation selon la norme IEC 61967-

4 (« mesure 150 Ω »), doit respecter le niveau maximal ‘H8’ défini à l’annexe C sur la bande 

de fréquence [1 MHz – 1 GHz].  

 

Votre travail consistera à : 

1. Etablir le budget de capacité de découplage permettant de garantir la contrainte sur le niveau 

d’émission maximal (nombre et valeurs des capacités de découplage) 

2. Réaliser le placement-routage du circuit imprimé, à partir de la schématique initiale et en 

intégrant les nouvelles capacités.  

Pour vous aider dans l’établissement du budget de capacité de découplage, les fabricants du 

STARCORE vous ont fourni un modèle équivalent de type SPICE (cf. annexe A), qui permet de simuler 

son activité transitoire. Vous disposez du logiciel IC-EMC (cf. annexe E) pour réaliser l’ensemble des 

simulations électriques nécessaires à l’établissement du budget de capacité de découplage. Le 

routage du circuit imprimé sera fait sous le logiciel ALTIUM Designer. 
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II. Annexe A – Données sur le STARCORE 
 

Le STARCORE est un microcontrôleur 16 bits, développé en technologie CMOS 0.18 µm. Il existe en 

différentes versions de boîtier, celui que vous allez utiliser est monté dans un boîtier QFP 64. Ce 

microcontrôleur embarque plusieurs types de périphériques, et notamment 5 ports digitaux 

bidirectionnels de 8 bits (PORT_A à PORT_E), 8 entrées analogiques (AN0 à AN5), un oscillateur et 

une PLL intégrée fonctionnant jusqu’à 64 MHz et référencée par un cristal ou quartz externe 

(connecté entre les broches XTAL et EXTAL). 

L’alimentation nominale du composant est 2.5 V. Celle-ci est fournie aux différents blocs par 

plusieurs paires d’alimentation : 

� Vdd1/Vss1 et Vdd2/Vss2 pour le cœur digital du microcontrôleur 

� VddIO1/VssIO1 et VddIO2/VssIO2 pour les entrées-sorties bidirectionnelles 

� VddPLL/VssPLL pour l’oscillateur et la PLL 

� VddA/VssA pour les blocs analogiques 

 

L’initialisation, la programmation et le debug in-situ du microcontrôleur sont commandés par les 

broches DEBUG et RESET. 

Brochage du circuit 

Numéro des 

broches 

Nom des broches 

1 - 8 PA0 à PA7 (PORT_A) 

9 - 10 Vdd1 et Vss1 

11 - 18 PB0 à PB7 (PORT_B) 

19 - 20 VddPLL et VssPLL 

21 - 22 XTAL et EXTAL 

23 - 24 VddIO1 et VssIO1 

25 - 32 PC0 à PC7 (PORT_C) 

 

Numéro des 

broches 

Nom des broches 

33 - 40 PD0 à PD7 (PORT_D)  

41 - 42 Vdd2 et Vss2 

43 - 46 AN0 à AN3 

47 - 48 VddA et VssA 

49 - 52 AN4 à AN7 

53 - 54 VddIO2 et VssIO2 

55 - 62 PE0 à PE7 (PORT_E) 

63 - 64 DEBUG et RESET 

 
 

 Configuration du composant pour la simulation 

Lors de la simulation du bruit d’alimentation du composant, on considérera l’activité suivante : 

� La PLL fonctionne à 64 MHz, elle est dérivée d’un oscillateur fonctionnant à 16 MHz. 
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� L’horloge du système est dérivée de la PLL et tourne à 32 MHz. 

� On considère qu’un seul port d’entrée-sortie commute à 2 MHz. 

� L’activité des blocs de conversion analogique numérique est cadencée par une horloge 

interne de 2 MHz de fréquence 

 

Modèle de l’activité du composant : 

Des modèles appelés « ICEM » (IEC 62433-2) des différents blocs du STARCORE sont fournis sur le site 

www.alexandre-boyer.fr. Ceux-ci décrivent l’activité transitoire d’un circuit et permettent de simuler 

le bruit d’alimentation, l’émission conduite et rayonnée issus de celui-ci. Les fichiers suivants sont 

fournis : 

� ICEM_core.sym : modèle ICEM du cœur digital. Celui-ci tourne à 32 MHz. 

� ICEM_PLL.sym : modèle ICEM de la PLL et de l’oscillateur à quartz. La PLL fonctionne à 64 

MHz, l’oscillateur à quartz à 16 MHz.   

� ICEM_ANALOG.sym : modèle ICEM des blocs analogiques 

� ICEM_IO.sym : modèle ICEM d’un port d’entrées-sorties du STARCORE. On chargera les 

sorties du port par des capacités de 10 pF. 

 

Ces fichiers peuvent être importés sous IC-EMC à l’aide de la commande « Insert > User Symbole 

(.SYM) ». 
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III.  Annexe B – Données sur le circuit imprimé 
 

La carte de circuit imprimé que vous devez réaliser aura les dimensions suivantes : 60 × 60 mm. Elle 

sera développée en FR4 4 couches. Ci-dessous, une description de l’empilement des 4 couches. 

Couches Signaux Type Epaisseur (mm) Conductivité / Constante 

diélectrique 

Top Ground + Signal Cuivre 0.035 57 MS / 0 

Diélectrique  FR4 0.4 0 / 4.5 

GND Ground Cuivre 0.035 57 MS / 0 

Diélectrique  FR4 0.7 0 / 4.5 

POWER Power Cuivre 0.035 57 MS / 0 

Diélectrique  FR4 0.4 0 / 4.5 

BOTTOM Signal + Ground Cuivre 0.035 57 MS / 0 

 

Tous les composants sont montés en surface. Par convention, le STARCORE sera monté sur la couche 

TOP. 

Modèle équivalent du plan d’alimentation 

Le plan d’alimentation POWER et le plan d’alimentation GND forment une cavité résonante, qui 

influe sur le niveau d’émission conduite. Le modèle équivalent de ce plan d’alimentation est donné 

par le fichier Board_model.sym.  

Schématique 

La schématique est disponible sur le site www.alexandre-boyer.fr, dans le fichier 

TP_CEM_board.SchDoc. Celle-ci a été créée à partir du logiciel ALTIUM DESIGNER. L’ensemble des 

composants et empreintes sont disponibles dans la librairieLib_TP_CEM.LibPck. 
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Règles de routage 

La carte sera réalisée en classe 4. Voici les contraintes sur les dimensions minimales : 

� Clearance min = 0.2 mm 

� largeur de piste minimale = 0.2 mm 

� Diamètre de via minimal = 0.762 

� Diamètre de trou minimal = 0.3 mm 

Alimentation de la carte 

 L’alimentation 2.5 V, notée VddBoard, de la carte est fournie par un régulateur LDO de type 

LT1963A. L’alimentation du régulateur, notée VddUnReg, et la référence de masse, notée Gnd, sont 

fournies par l’intermédiaire du connecteur noté Psupply. L’alimentation VddUnReg est filtrée sur la 

carte par une capacité tantale de 10 µF. Une seconde capacité tantale de 10 µF est placée en sortie 

du régulateur pour améliorer sa stabilité et filtrer le bruit en sortie du régulateur. 

Le modèle du régulateur est donné par le fichier Model_LDO.sym. La capacité tantale de 10 µF est 

affectée d’une inductance série de 3 nH et d’une résistance série de 80 mΩ. 

Connexion des broches XTAL et EXTAL 

Les broches XTAL et EXTAL sont connectées à un quartz externe de 4 MHz, notée Quartz, et à 2 

capacités céramique Cosc1 et Cosc2 de 10 pF. 

Connecteur de sortie 

Les broches du microcontrôleur (mis à part les broches d’alimentations, XTAL et EXTAL) sont 

accessibles sur deux connecteurs appelés Pout1 et Pout2, formés de deux rangées de 15 broches. 
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Capacité de découplage 

On utilisera des condensateurs de type X7R – 50 V montés en boîtier 0603 pour le découplage des 

alimentations. Afin de déterminer les modèles électriques de ces condesateurs, on utilisera l’outil en 

ligne SimSurfing fourni par le fabricant de composants passifs Murata 

(http://ds.murata.com/software/simsurfing/en-us/index.html).   

On supposera que les pads et les vias employés pour connecter les capacités de découplage aux 

plans d’alimentation et de masse ajoutent une inductance parasite de 1.5 nH. 
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IV. Annexe C – IEC 61967-4 - Mesure 150 ohms 
 

La norme IEC61967 définit des méthodes de qualification CEM des circuits intégrés sur la bande 150 

KHz – 1 GHz. La norme IEC61967-4 définit deux méthodes de caractérisation de l’émission 

électromagnétique conduite des circuits. Parmi les méthodes que la norme propose, nous utiliserons 

la méthode dite 150 Ω. Celle-ci consiste à réaliser une mesure de la tension sur une broche donnée 

du circuit (sortie, alimentation) en plaçant en sortie de celle-ci la sonde suivante : 

 

Sonde 150 Ω (IEC 61967-4) 

La norme définit aussi des gabarits donnant les limites d’émission d’un composant. Le STARCORE doit 

respecter la limite d’émission définie par le gabarit H8.  

 

Limites d’émission définies par la norme IEC 61967-4 
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Annexe D – Emission électromagnétique  
 

L’émission électromagnétique d’un composant électronique trouve son origine dans les fluctuations 

de tension (principalement d’alimentation et de masse) produites par son activité. Celle-ci est dite 

conduite lorsque celles-ci se propagent le long d’interconnexions, rayonnée lorsqu’elles excitent une 

antenne parasite du système électronique et produisent un rayonnement électromagnétique. Dans 

les deux cas, un circuit dit émetteur est capable de perturber tout composant situé à proximité (voire 

lui-même). 

Prenons un circuit numérique simple : un inverseur. Celui-ci est connecté à une charge capacitive, 

représentant l’entrée d’un autre circuit digital. Chaque changement d’état de l’entrée de l’inverseur 

conduit à l’apparition d’un courant transitoire entre l’alimentation et la masse à travers la capacité 

de charge. Ce courant correspond au transfert de charge, lié à la charge ou à la décharge de la 

capacité de sortie. Ainsi, tout circuit en commutation est à l’origine l’apparition d’un courant 

transitoire entre l’alimentation et la masse : circuits digitaux synchrones, entrée-sortie digitale (E/S), 

convertisseur de tension, driver de puissance … 

VDD

VSS

Charge

Vin

IDD 

(0.1mA)

ISS  (0.1mA)

1 ���� 0

0 ���� 1

Vout

VOUT

Termps
I

IDD ISS 

Termps

0.1 mA

 

Courant transitoire produit par l’activité d’un inverseur 

Tant que l’on considère une alimentation ou une référence de masse idéale connectée à ce circuit, 

aucun problème d’émission ne peut apparaître puisqu’il ne peut y avoir de fluctuations des niveaux 

d’alimentation ou de masse. Cependant, un circuit n’est jamais connecté directement à la source 

d’alimentation (batterie, régulateur de tension …). Un ensemble d’interconnexions relie les broches 

d’alimentation et de masse d’un circuit aux références d’alimentation et de masse, qu’on appelle 

réseau de distribution d’alimentation (Power Distribution Network PDN).  

L’impédance du PDN n’est malheureusement pas nulle. La circulation du courant transitoire créée 

par l’activité du circuit le long des interconnexions du réseau de  distribution de l’alimentation est à 

l’origine de fluctuations des tensions d’alimentation et de masse appliquées au circuit. Ce réseau est 

composé de résistances et d’inductances distribuées. Les résistances sont à l’origine d’une chute de 

potentiel constante (on parle d’IR drop) et les inductances d’une fluctuation rapide liée aux variations 

de courant (delta I noise). C’est ce dernier phénomène qui produit la variation la plus importante. 
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Circuit 
digital

Alimentation

PDN

Vss

Vdd

i(t)

Circuit

PDN

∆Vdd

∆Vss

Bruit d’alimentation :
t

i
LiRV PDNPDN ∆

∆+=∆
Delta-I noise

 

Origine du bruit d’alimentation d’un circuit 

La figure ci-dessous présente un exemple de mesure du bruit lié à la commutation d’un 

circuit digital synchrone, réalisé sur sa ligne d’alimentation. A chaque période d’horloge, le 

circuit génère un appel de charges, qui produit un courant transitoire très rapide, donc 

présentant un spectre riche en harmoniques. Lorsque ce courant excite des résonances 

associées aux inductances de ces différentes interconnexions et à la capacité que représente 

le circuit en commutation, la fluctuation de tension est amplifiée. Sur la figure ci-dessous, on 

peut voir 2 contributions, une basse fréquence (une période proche de 10 ns), une autre 

haute fréquence (une période proche de 1 ns), liée à des résonances circuit-boîtier-PCB 

différentes. 

Commutation Commutation Commutation

Contribution 
très haute 
fréquence

Contribution 
basse 

fréquence

 

Exemple de mesure du bruit d’alimentation d’un circuit 

Comment réduire l’émission électromagnétique produite par un circuit intégré ? Une des solutions 

consiste à faire passer le courant transitoire par un chemin de faible impédance. Considérons le 

schéma de principe ci-dessous. Le circuit est modélisé par un simple générateur de courant IIC, 

représentant les appels en courant liés à l’activité du circuit. Les deux terminaux de ce générateur 

sont respectivement les potentiels d’alimentation et de masse. L’alimentation Vdd et la masse gnd 

sont fournies à travers un réseau de distribution d’alimentation relativement complexe, qu’on 

représente par une impédance équivalente ZPDN(f), connectée entre Vdd et gnd. Cette impédance est 

une grandeur complexe dépendante de la fréquence. Dans le domaine fréquentiel, la fluctuation de 

tension ΔVdd produite par le passage du courant du circuit à travers le réseau de distribution 

d’alimentation est égal à : 
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( ) ( ) ( )fIfZfV ICPDNdd ×=∆  

IIC

Circuit
Vdd

gnd

ZPDN

PDN

∆Vdd

 

Pour réduire la fluctuation de tension d’alimentation et donc l’émission conduite, il est nécessaire de 

réduire l’impédance du réseau de distribution d’alimentation. On peut définir le concept 

d’impédance cible Zt qui fixe l’impédance maximale que doit présenter le PDN pour garantir une 

fluctuation de tension d’alimentation inférieure à une limite donnée ΔVddmax, connaissant la valeur 

maximale ΔI du courant transitoire appelé par le circuit : 

( ) ( )
( )fI

fV
ZfZ

IC

dd
TPDN

max∆
=<

 

Comment s’y prendre, sachant que celle-ci est liée aux caractéristiques des géométriques des 

interconnexions, des plans d’alimentation … ? La solution réside dans l’utilisation de capacité de 

découplage, placée entre l’’alimentation et la masse. Celle-ci peut être vue de 2 manières : 

� Dans le domaine temporel, une capacité de découplage sert de réservoir local de 

charges qui doit fournir rapidement du courant au circuit en commutation. 

� Dans le domaine fréquentiel, une capacité de découplage constitue une faible 

impédance placée entre l’alimentation et la masse (Z = 1/(jCω)), donc en parallèle de 

ZPDN. Si l’impédance équivalente de la capacité de découplage est inférieure à ZPDN, 

alors elle court-circuite le courant transitoire produit par le circuit. 

Régulateur de 
tension Circuit

PCB

Capacité de 
découplage

Vdd

Vss

Plan Vdd

Plan Vss

Bruit d’alim.

Circulation du 
courant transitoire

 

Capacité de découplage 

Un autre intérêt réside dans la réduction de la surface de la boucle suivie par le courant transitoire. 

En effet, celle-ci constitue une antenne parasite capable de produire une émission 
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électromagnétique rayonnée. La réduction de l’émission électromagnétique rayonnée justifie de 

placer les capacités de découplage au plus près du composant à découpler. En outre, cela réduit la 

longueur du chemin parcouru par le courant et donc les inductances et résistances parasites qui 

produisent les fluctuations de tension. 

Comment choisir une capacité de découplage. Celle-ci doit être capable de réagir rapidement à un 

appel de charge, c'est-à-dire fournir suffisamment de courant sans induire de fluctuation de potentiel 

à ses bornes. Soit ΔVddmax la fluctuation maximale de tension tolérée, ΔI le pic de courant produit par 

la commutation du circuit et tr la durée de ce pic de courant, la capacité de découplage doit 

présenter une valeur supérieure à la valeur ci-dessous :  

maxdd

r
dec V

tI
C

∆
×∆≥

 

Malheureusement, ce raisonnement ne tient pas compte du caractère non idéal de toute capacité. 

en effet, celle-ci est affectée de résistances et d’inductances parasites. Une capacité réelle peut être 

modélisée par le modèle ci-dessous.  

Capacité de 
découplage

Plan Vdd

Plan Vss

Modèle 
équivalent

via

 

Le profil d’impédance d’une capacité réelle est donné ci-dessous. Celle-ci se comporte comme une 

capacité jusqu’à une certaine fréquence de résonance entre la capacité et l’ensemble des 

inductances parasites. Ce condensateur sera une capacité de découplage efficace que sur une plage 

de fréquence sur laquelle elle présente une faible impédance (là où l’impédance de la capacité est 

inférieure à ZPDN). 

ωC
Z

1= ωLZ =

ESR

LC
f

π2

1
0 =

 

Profil d’impédance d’une capacité de découplage 

Ci-dessous deux exemples de mesures d’impédance de capacité céramique X7R de différentes 

valeurs et  une capacité électrolytique de 100 µF. 
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Vias non pris en compte

 

Profil d’impédance de capacités céramiques X7R (source : Murata) 

, 

 

Profil d’impédance d’un condensateur électrolytique de 100 µF 
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V.  Annexe E – Prise en main du logiciel IC-EMC  
IC-EMC (Integrated Circuit Electromagnetic Compatibility) est un logiciel gratuit dédié à la 

modélisation et à la simulation des problèmes d’émission électromagnétique et de susceptibilité des 

circuits intégrés. Celui-ci est téléchargeable sur la page www.ic-emc.org. L’outil fonctionne avec le 

simulateur WinSPICE (www.winspice.com).  IC-EMC propose un éditeur de schématique SPICE et tout 

un ensemble d’outils permettant la construction de modèles électriques et d’analyse des résultats. 

Cette annexe décrit les principales étapes et les commandes associées qui vous aideront durant ce 

TP. La figure ci-dessous présente l’écran principal du logiciel, qui permet la saisie de schématiques 

électriques (fichiers .sch), qui seront converties en netlist SPICE (fichiers .cir). A gauche de l’écran se 

trouve une palette de symboles aidant à la construction de schémas électriques. En haut de l’écran 

se trouvent le menu principal et un ensemble d’icônes décrites dans le tableau ci-dessous.  

 

Ecran principal d’IC-EMC 

Open schematic (.sch) Build SPICE netlist (.cir)

Save schematic (.sch) Spectrum analysis

Delete symbols Near field emission simu.

Copy symbols Immunity simulation

Move symbols Time domain analysis

Rotate symbols Impedance simulation

Flip symbols S parameter simulation

Add Text line Ibis file editor

Add a line Parametric analysis

View electrical net Symbol palette

Zoom in/out View all schematic
 

Principales icônes et commandes associées 
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Les schémas électriques sont construits en sélectionnant des composants de la palette et en les 

faisant glisser sur l’écran principal. En cliquant sur les symboles placés, il est possible de modifier 

leurs propriétés. Les principaux symboles dans la palette que vous utiliserez sont donnés dans le 

tableau ci-dessous. En outre, vous serez amenés des sous-circuits (fichiers .sym) contenant les 

modèles ICEM des différents blocs du STARCORE. Pour cela, cliquez dans le menu sur la commande 

Insert > User Symbol (.SYM).  

 Résistance 
 

Générateur de tension (pulse, sinus, PWL)  

 Capacité  Générateur de courant (pulse, sinus, PWL) 

 Inductance  Sonde de tension (sur un nœud) 

 Référence de tension DC 
 

Sonde de courant (à l’intérieur d’une branche) 

 Référence de masse 
 

Port – Mesure de paramètres S et d’impédance 

Principaux symboles utilisés dans ce TP 

Une fois une schématique saisie et sauvegardée, il est nécessaire de configurer une simulation SPICE. 

Pour cela, il est nécessaire d’inclure une ligne de commande sur la schématique en cliquant sur 

l’icône  puis en cliquant sur l’écran de la schématique. Le tableau ci-dessous donne les principales 

commandes de simulation (transitoire, DC, AC). 

Simulation command Command line Parameters

Transient simulation .tran 0.1n 100n step + stop time

DC simulation .DC Vdd 0 5 0.1 source + start + stop + step

Small signal freq. 
analysis

.AC DEC 100 1MEG 1G sampling + nb points + start + 
stop

 

Principales commandes de simulation 

Avant de lancer la simulation SPICE, il est nécessaire de convertir la schématique en netlist 

compatible avec WinSPICE. Pour cela, cliquez sur l’icône . Si le nom donné au fichier de 

schématique est nom_schéma.sch, alors la netlist prendra automatiquement le nom 

nom_schéma.cir. Pour lancer la simulation SPICE, il est nécessaire d’ouvrir le simulateur WinSPICE 

puis de chercher la netlist à simuler (fichier .cir) en cliquant sur File > Open. L’interface WinSPICE 

permet de visualiser l’avancement de la simulation, les erreurs éventuelles et certains résultats de 

simulation.  

Une fois la simulation WinSPICE terminée, les résultats de simulation peuvent être visualisés sur IC-

EMC. Vous serez amenés à réaliser deux types de simulation : transitoire et impédance (ou 

paramètres S). Pour observer le résultat d’une simulation transitoire, cliquez sur l’icône . La 

fenêtre ci-dessous s’ouvre. 
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Visualisation des résultats de simulation temporelle 

A partir de cette fenêtre en cliquant sur le bouton  ou directement depuis l’écran principal 

en cliquant sur l’icône , il est possible de réaliser une transformée de Fourier du résultat de 

simulation transitoire. La figure ci-dessous présente la FFT du résultat de simulation temporelle 

présentée ci-dessus. Ce type de résultat permet d’obtenir le spectre de la fluctuation de tension 

responsable de l’émission électromagnétique et de le comparer par rapport à la limite maximale 

définie par le standard. En cliquant sur la box Limit et en entrant (H8), une limite rouge apparaît sur 

l’écran, indiquant le niveau maximal d’émission conduite en fonction de la fréquence. 

 

Transformée de Fourier d’un résultat de simulation temporelle 

Pour observer les résultats de simulation d’impédance, cliquez sur l’icône . Les résultats peuvent 

être affichés sous forme de paramètres S ou Z (impédance). Pour sélectionner le mode d’affichage 

des résultats, dans le champ Conversion, sélectionnez S ou Z. Vous pouvez afficher les résultats dans 

graphique aux échelles logarithmiques en cliquant dans les boxes Log. 
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Visualisation des résultats de simulation d’impédance 

 


